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SELAMAT DATANG KE DUNIA KESAN VISUAL

Dalam dunia kreatif hari ini, Visual Effects (VFX) dan Motion Graphics
telah menjadi antara aspek terpenting dalam industri media, filem,
pengiklanan dan pendidikan digital.

Kesan visual bukan sekadar tambahan kepada
video tapi ia ialah bahasa Vvisual yang
menyampaikan emosi, naratif, dan mesgj
dengan lebih mendalam dan berkesan.

VEX DENGAN
ADOBE AFTER EFFECTS

SIRI 1: Pengenalan dan

Asas Komposisi

Buku “VFX dengan Adobe After Effects — Dari Novis ke Pakar” ini
ditulis sebagai panduan menyeluruh kepada pembaca yang ingin
memahami serta menguasai seni dan sains di sebalik penciptaan
kesan visual moden. la direka khusus untuk pelajar politeknik, institusi
TVET, pengamal industri kreatif, serta mana-mana individu yang
berminat untuk mengembangkan kemahiran dalam bidang digital
compositing, motion design dan cinematic storytelling.

>

Oleh itu, buku ini bukan sekadar panduan pembelajaran
perisian, tetapi juga merupakan panduan untuk memahami
bagaimana prinsip reka bentuk visual, pencahayaan, warna

dan pergerakan boleh digabungkan untuk menghasilkan
pengalaman visual yang menyentuh emosi penonton.
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IS| KANDUNGAN

BAB 1 - Pengenalan kepada VFX dan Antaramuka 04
After Effects

Bab ini memperkenalkan asas dunia Visual Effects (VFX) dan
perisian Adobe After Effects.

Pelajar akan memahami fungsi antara muka utama seperti
Project Panel, Composition Window, dan Timeline.

Turut diterangkan langkah asas mencipta komposisi,
mengimport bahan, menggunakan lapisan (layers), serta
membuat animasi dan eksport video asas.

BAB 2 - Asas Visual Effects 14

Bab ini memperkenalkan konsep dan teknik asas dalam
penghasilan kesan visual (VFX) menggunakan Adobe After
Effects.

Pelajar akan mempelajari cara menggabungkan elemen
visual seperti imej, video dan grafik untuk mencipta kesan
realistik. Topik utama termasuk penggunaan masking, keying
(green screen), color correction, serta pengenalan kepada
tracking dan compositing.

Melalui aktiviti praktikal, pelajar akan memahami bagaimana
VEX digunakan untuk menambah nilai visual dalam filem,
iklan, dan kandungan digital.



SIRI 1: Pengenalan dan Asas Komposisi




SIRI 1: Pengenalan dan Asas Komposisi

Bab 1:

Pengenalan kepada
After Effects

Modul pertama ini berfungsi Berdasarkan asas tersebut,
sebagai pengenalan asas anda akan mempelajari

kepada perisian Adobe After penguasaan timeline, teknik
Effects. Dalam modul ini, anda penyusunan komposisi, serta
akan didedahkan secara manipulasi lapisan (layer
mendalam kepada manipulation). Modul ini juga
antaramuka (interface) After memperkenalkan beberapa ciri
Effects, termasuk cara lanjutan bagi membantu anda
mencipta komposisi baharu, memahami sepenuhnya potensi
mengimport serta menyusun dan keupayaan After Effects
rakaman dengan efisien, dan sebagai perisian utama dalam
mengurus pelbagai format fail penghasilan animasi dan kesan
dengan betul. visual profesional.

Mencipta Komposisi dalam After Effects

e et Welcome to After Effects, Siti Izani

Al(converted)

New Team Project

Open Team Project
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Rajah 1.1

Antaramuka utama Adobe After Effects 2024

e Untuk memulakan kerja e Composition Panel —
dalam After Effects, kawasan pratonton
pengguna perlu utama untuk melihat
mencipta projek baharu hasil kerja.
(New Project). e Apabila belum ada

e Antaramuka utama komyposisi atau rakaman
After Effects dimasukkan, paparan
mengandungi: akan menunjukkan

e Project Panel —tempat status “none”.
mengurus semua fail e Untuk mula bekerja, pilih
dan aset projek. New Composition atau

e Effect Controls Panel — New Composition From
digunakan untuk Footage — kedua-duanya
melaras kesan (effects) digunakan untuk
yang digunakan pada mencipta komposisi
lapisan. pbaharu, sama ada kosong

atau berdasarkan
rakaman yang diimport.
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2. Composition Window
4.}E.ff1ects & Presets Panel
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1. Project Panel
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3. Timeline

1. Project Panel

Fungsi:
Panel ini ialah tempat utama untuk menyimpan dan mengurus
semua bahan projek seperti gambar, video, audio, komposisi
(composition) dan aset lain. la berfungsi seperti folder library yang
menyenaraikan semua elemen yang digunakan dalam satu projek
After Effects.
Kegunaan:
e Mengimport bahan mentah (import file) ke dalam projek.
e Mengatur fail dalam folder (bins) untuk memastikan struktur
projek kemas.
e Menyusun semula atau menukar nama fail agar mudah dicari.
e Menyemak maklumat media seperti durasi, format, dan resolusi.
83 Shortcut Penting:
o Ctrl+ | (Windows)/Cmd + | (Mac): Import fail baharu ke dalam
Project Panel.
e Enter (Return): Tukar nama item yang dipilih.
e Delete: Padam item daripada senarai projek (tidak padam fail
asal dalam komputer).
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2. Composition Window

Fungsi:

Composition Window ialah kawasan paparan utama tempat anda
melihat hasil kerja secara visual. Apa sahaja perubahan pada
layers, effects, atau animation, akan dipratonton di sini secara
langsung.

Kegunaan:

¢ Menyunting elemen visual secara terus (contohnya mengubah
saiz, kedudukan atau putaran).

e Melihat preview kesan visual, animasi, dan gerakan tipografi.

¢ Menentukan kawasan aktif dalam composition (melalui region
of interest).

e Menguji motion blur, cahaya, dan bayangan secara masa nyata.

Shortcut Penting:

e Ctrl + K/ Cmd + K: Buka tetapan Composition Settings.

e ~ (tilde): Maksimumkan paparan panel semasa (contohnya
Composition Panel).

e Spacebar: Main (Play) atau jeda (Pause) preview animasi.

3. Timeline Panel

Fungsi:

Panel ini berperanan sebagai garis masa (timeline) untuk
menyusun semua layers dalam komposisi. Di sinilah anda
mengawal bila sesuatu elemen muncul, hilang, atau bergerak.

Kegunaan:

¢ Mengatur susunan lapisan (gambar, teks, video, audio).

e Mengawal masa mula (start time) dan tamat (end time) sesuatu
elemen.

e Menambah keyframe untuk animasi seperti position, scale,
rotation dan opacity.

e Melihat serta mengawal tempoh keseluruhan komposisi.

Shortcut Penting:

P: Paparkan tetapan Position bagi layer terpilih.

S: Paparkan tetapan Scale.

R: Paparkan tetapan Rotation.

T: Paparkan tetapan Opacity (Transparency).

U: Tunjukkan semua keyframe dalam layer.

Alt + [/ ]: Potong permulaan atau penghujung layer pada titik
semasa.

e B & N: Tetapkan titik Begin dan End untuk kawasan work area.
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4, Effects & Presets Panel

Fungsi:

Panel ini memaparkan semua kesan khas (effects) dan pratetapan
(presets) yang boleh digunakan untuk menambah gaya visual
kepada projek. la memudahkan anda mencari, memilih, dan
menerapkan kesan ke atas layer dengan cepat.

Kegunaan:

« Menambah kesan seperti blur, glow, color correction, keying, atau
distortion.

¢ Menggunakan animation presets untuk teks, transisi dan grafik
gerakan.

¢ Menyimpan preset tersuai untuk digunakan dalam projek lain.

¢ Menyemak kategori kesan mengikut fungsi (Audio, Blur &
Sharpen, Color Correction, Distort, Keying, Stylize, dan lain-lain).

Shortcut Penting:
o Ctrl+5/Cmd + 5: Buka atau tutup Effects & Presets Panel.
o Ctrl + Space /Cmd + Space: Buka Effects Search Bar (guna FX
Console Plugin jika tersedia).
o Ctrl + Shift + E/Cmd + Shift + E: Padam semua effects daripada
layer terpilih.
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Tetapan Komposisi Baharu
(Composition Settings)

projet = & comp
>
=g
e (one) =
cvea @ 2s\ABOGE « or

Rajah 1.2: Tetapan Komposisi Baharu dalam After Effects.

Composition Settings

Basic  Advanced 3D Renderer

Tetingkap Composition Settings
digunakan untuk menentukan saiz,

Preset: Custom v
Wit 2816 : kadar bingkai, tempoh dan warna
b g e latar belakang sesuatu komposisi
s [ 4 et sebelum memulakan kerja animasi
etz P (€ Cv=es) atau kesan visual. la merupakan
Resolution: ol ~ | 2016x1536,165 M3 por bpc fame langkah paling penting dalam

Start Timecode:

0:00:00:00 i5 0:00:00:00 Base 25

menyiapkan ruang kerja asas anda
dalam Adobe After Effects.

Duration:  0:00:10:00 is0:00:10:00 Base 25

Background Color: _ A White

ar

1
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AT 1.composition Name

Composition Name:  Comp 1

Basic  Advanced 3D Renderer
Preset: Custom v =
v Custom
Width
HD - 1920x1080 - 24 fps
Helght 15 . 1920x1080 - 25 fps
Pixel Aspect Ratio:  HD - 192011080 - 29.97 fps Frame Aspect Ratio
116 (183)
UHD (4K) - 384012160 - 23976 fps
Frame Rate:

UHD (4K) - 3840x2160 - 25 fps
UHD (4K) - 3840x2160 - 29.97 fps

Resolution: bpc frame
UHD (8K) - 7680x4320 - 23976 fps

.
StartTimecode: ¢ .| Media Portrait HD - 1080x1920 - 30 fps

Duration:  Social Media Landscape HD - 1920x1080 - 30 fps
Social Media Portrait + 720x1280 - 30 fps
Background Color. Social Media Landscape - 1280x720 - 30 fps
Social Media Square - 1080x1080 - 30 fps
HDV/HDTV - 1280x720 - 25 fps
HDV/HDTV - 1280x720 - 29.97 fps
HDV - 1440x1080 (1.33) - 25 fps

Nama komposisi anda.
Digunakan untuk mengenal pasti
komposisi dalam Project Panel.
Setiap komposisi boleh dianggap
sebagai satu “adegan” atau “bab”
dalam video.

# Contoh: “Intro_Text", “Scene_1",
“Logo_Reveal".

2. Preset

Pilihan pratetapan (preset)
membolehkan anda memilih format

standard mengikut keperluan projek.
e Contoh: HDV 1080p 25, 4K UHD

HDV - 144041080 (1.33) - 2997 s Cancel ) 3840x2160, Instagram Square

DVCPRO HD - 960x720 (1.33) - 23.976 fps
DVCPRO HD - 960x720 (1.33) - 25 fps.
DVCPRO HD -« 960x720 (1.33) - 29.97 fps
DVCPRO HD - 1440x1080 (1.33) - 25 fps
DVCPRO HD - 1280x1080 (1.5) - 29.97 fps
Cineon Half - 1828x1332 - 24 fps

Cineon Full - 3656x2664 - 24 fps

Film (2K) - 2048x1556 - 24 fps

Film (4K) + 4096x3112 - 24 fps

3. Width dan Height

Menentukan saiz bingkai (frame size)
dalam piksel.
e Width (Lebar) dan Height (Tinggi)
menentukan resolusi video.
e ¢ Contoh biasa:
o Full HD: 1920 x 1080 px
o 4K: 3840 x 2160 px
o Square: 1080 x 1080 px
A Tip: Gunakan nisbah aspek 16:9
untuk video landskap dan 9:16 untuk
video potret.

4. Lock Aspect Ratio

Menetapkan supaya nisbah lebar dan
tinggi kekal seimbang apabila diubah.

Tandakan kotak ini jika mahu
mengekalkan nisbah aspek tertentu.

Biarkan tidak ditanda jika mahu ubah
width dan height secara bebas.

1080x1080.
e Jika ingin menyesuaikan secara
manual, pilih Custom.
# Tip: Gunakan preset mengikut
. platform akhir — contohnya 1920x1080
(YouTube), 1080x1920
(TikTok/Instagram Reels).

Preset: Custom v n
Width: 2816 px

(0] Lock Aspect Ratio to 11:6 (1.83)
Height: 1536 px

Pixel Aspect Ratio:  Square Pixels ~ Frame Aspect Ratio
11:6 (183)

Frame Rate: 25 ~ frames persecond

Resolution:  Full

StartTimecode: 0:00:00:00  is 0:00:00:00 Base 25

Duration:  0:00:10:00 is0:00:10:00 Base 25

Background Color: ﬁ| A White

o]4

5. Pixel Aspect Ratio

Menentukan bentuk piksel dalam
komposisi.

Pilihan umum: Square Pixels (piksel segi
empat sama).

Digunakan untuk kebanyakan video
digital moden.

# Lain-lain pilihan (jarang digunakan):
D1/DV NTSC, HD Anamorphic —
digunakan untuk rakaman video lama.

12
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Composition Settings

Composition Name

Resolution: ~ Full v 36,16:5 MB per 8bpc frame

Start Timecode:  0:00:00:00  is 0:00:00:00 Ba:

Duration:  0:00:10:00

Background Color: [l 2 white

5 0:00:10:00 Base 25

o]4
Ce=

7. Resolution

Menentukan kualiti pratonton
(preview resolution).

Full: Kualiti penuh, lebih tajam
tetapi berat.

Half / Third / Quarter: Kurangkan
beban CPU semasa kerja.

¢ Cunakan Half semasa
mengedit untuk kelancaran, dan
Full semasa render akhir.

9. Duration

Menetapkan tempoh masa
keseluruhan komposisi.
o Nilai ditulis dalam format
jam:minit:saat:bingkai.
e # Contoh: 0:00:10:00
bermaksud 10 saat.
¢ Anda boleh ubah tempoh bila-
bila masa (Ctrl/Cmd + K).

www.shelfridgebooks.com

6. Frame Rate

Menetapkan bilangan bingkai
sesaat (frames per second / fps).
o Nilai biasa:
o 24 fps —gaya sinematik
(filem)
o 25 fps-standard
televisyen PAL (Malaysia)
o 30 fps - platform digital
(YouTube, media sosial)
o 60 fps—animasi gerakan
pantas/ permainan video
# Tip: Gunakan 25 fps untuk
projek akademik dan penyiaran
standard di Malaysia.

8. Start Timecode

Menentukan masa permulaan
komposisi.

e Lalai: 0:00:00:00
(Jam:minit:saat:bingkai).

e Boleh ubah jika ingin
selaraskan dengan video lain
atau projek multi-scene.

¢ Contoh: Jika babak kedua
bermula pada minit ke-2, setkan
00:02:00:00.

10. Background Color

Menentukan warna latar
belakang untuk komposisi.

e« Warna ini hanya kelihatan
dalam Composition Window
jika tiada layer video atau imej
di bawahnya.

e Warna asal biasanya hitam,
tetapi boleh diubah kepada
putih atau warna lain.

e £ Tip: Gunakan warna neutral
seperti kelabu muda untuk
reka bentuk tipografi atau Ul
motion graphics.

I\ s
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Toolbar dalam Adobe
After Effects

Adobe After Effects 2024 - Untitled Project *

D OAT S L& i *

M & Composition Comp 1 =

omp 1v Comp
2816 x 1536 (1.00)
£0:00:10:00, 25.00 fps

Fungsi Utama:

Toolbar ialah bar alat di bahagian atas antara muka (interface) After
Effects. la digunakan untuk membina, memilih, melukis, dan
mengubah elemen visual dalam komposisi.

Setiap ikon mewakili alat berbeza dengan fungsi tertentu.

1. Selection Tool (V) 2. Hand Tool (H / Spacebar)
Fungsi: Fungsi:
Alat paling asas — digunakan Digunakan untuk mengalih
untuk memilih, menggerakkan, pandangan (panning) dalam
dan mengubah saiz objek atau kawasan komposisi atau
lapisan dalam Composition timeline tanpa mengubah
Window. objek.
Kegunaan: Kegunaan:
e Seret objek ke kedudukan o Navigasi dalam komposisi
baharu. bersaiz besar.
e lLaras saiz, putaran dan titik o Gerakkan paparan tanpa
rujukan (anchor point). menjejaskan posisi elemen.
e Digunakan dalam hampir Shortcut:
semua langkah H — aktifkan alat tangan.
penyuntingan. Spacebar (tahan) — sementara
Shortcut: V aktifkan Hand Tool.

(Tekan V pada papan kekunci
untuk aktifkan Selection Tool.)
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roject = ect Co ne)
cor
28 536 (1.00)
£0:00:10:00, 25.00 fps

Adobe After Effects 2024 - Untitled Project *

3. Zoom Tool (Z)

Fungsi:
Untuk membesarkan (zoom
in) atau mengecilkan (zoom
out) paparan dalam
Composition Panel.
Kegunaan:
e Fokus pada kawasan kecil
untuk kerja terperinci.
e Gunakan bersama
Alt/Option untuk zoom out.
Shortcut:
Z—zoom in
Alt + Z / Option + Z — zoom out

5. Camera Tools (C)

Fungsi:
Untuk mengawal kamera
maya (3D Camera) dalam ruang
3D.
Kegunaan:
e Orbit (pusing) pandangan
kamera.
e Track kamera ke Kiri, kanan,
atas, bawah.
e Zoom kamera ke
dalam/keluar dari subjek.
Shortcut: C (tekan berulang
untuk tukar mod Orbit, Track
XY, Track Z).

4. Rotation Tool (W)

Fungsi:
Untuk memutar (rotate) objek
atau lapisan dalam ruang 2D
dan 3D.
Kegunaan:
e Putar teks, imej atau elemen
grafik.
e Dalam 3D, boleh ubah paksi
X, Y, dan Z.
Shortcut: W

6. Pan Behind (Anchor Point
Tool) (Y)

Fungsi:
Untuk mengubah titik pusat
objek (anchor point) tanpa
mengubah kedudukan sebenar
objek.

Kegunaan:

¢ Penting untuk menentukan
pusat putaran, skala atau
animasi.

e Contoh: letak anchor point
di bawah kaki karakter
sebelum animasi berdiri.

Shortcut: Y
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£ 0:00:10:00, 25.00 fps

Adobe After Effects 2024 - Untitled Project *

7. Shape Tool / Mask Tool (Q)

Fungsi:
Untuk melukis bentuk (shape)
seperti segi empat, bulatan,
poligon atau bintang, serta
mask (topeng) pada layer video
atau imej.
Kegunaan:
e Lukis objek grafik seperti
circle, rectangle, polygon.
e Buat masking untuk
sorok/nyah bahagian video.
e Gunakan Shift untuk bentuk
simetri sempurna.
Shortcut:
Q (tekan berulang untuk tukar
antara Rectangle, Ellipse,
Polygon, Star).

9. Text Tool (Cmd/Ctrl + T)

Fungsi:

Untuk menambah teks tajuk,
subteks, atau tipografi animasi
dalam komposisi.

Kegunaan:

e Tambah teks statik atau

animasi.

8. Pen Tool (G)

Fungsi:
Untuk melukis laluan (path)
tersuai bagi animasi, bentuk
atau mask kompleks.
Kegunaan:
e Lukis mask mengikut
bentuk objek dalam video.
e Lukis motion path untuk
pergerakan tersuai.
o Gunakan Alt/Option untuk
ubah Bezier curve.
Shortcut: G

10. Brush Tool (Ctrl + B)

Fungsi:
Untuk melukis terus pada layer
menggunakan berus digital.
Kegunaan:
e Sesuai untuk kesan hand-drawn
animation atau paint effect.
¢ Gunakan bersama Paint Panel
dan Timeline.
Shortcut: Ctrl + B/Cmd + B

11. Clone Stamp Tool (Alt + B)
Fungsi:

« Gunakan Character & Paragraph Untuk menyalin dan menampal

Panel untuk ubah jenis, saiz,
warna, dan perenggan teks.
Shortcut:
Ctrl + T/Cmd + T — aktifkan alat
teks.
Enter — tukar baris.

Ctrl + Enter / Cmd + Enter — keluar

dari mod teks.

(clone) bahagian imej bagi
menutup kecacatan atau objek
tidak diingini.
Kegunaan:
e« Digunakan dalam video cleanup
atau object removal.
e Sama seperti Clone Tool dalam
Photoshop.
Shortcut: Alt + B
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Adobe After Effects 2024 - Untitled Project *

N ¥ Q D OMAT /L& 0 *, Osnapping < =5

Project = Effect Controls (none) x & Composition C Layer (none)
womp1v Comp 1
- 2816 x 1536 (1.00)
A 0:00:10:00, 25.00 fps
+
12. Eraser Tool (Ctrl + E) 13. Puppet Tool (Ctrl + P)
Fungsi: SUEEL

Menambah titik kawalan (pins)
pada imej atau objek supaya

Padam atau mask out
bahagian yang dilukis dengan

Sve reel. Eolehkdigerakkan seperti
Kegunaan: ONEKa. :

e Padam lukisan sementara nggun{aan K ani :
atau tetap. . kesulj\ unztu amrEag

e Buat kesan animation ara ter D(gera tangan,
vl kaki, ekspresi).

o Shortcut: Ctrl + E/ Cmd . GAunakan Mesh dah pu"?pet
+E Pin Tool untuk hasil lebih

realistik.
Shortcut: Ctrl+ P/Cmd + P
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Struktur Panel Timeline
dalam Adobe After
Effects

Parenting Time Graph Comp Marker

Pane Panel Area Bin
Current Time 3Q AnimatedGif_Example

N 2s e > \

AN features
Panel

Layer Details /
: None

= Layer
“Timeiie’
iyl Duration Bar il
Timeline Frame Level Cor;z::rrln ity
Panes Zoom

1. Current Time Display

Menunjukkan masa semasa
(current time indicator) dalam
format jam:minit:saat:bingkai
(contohnya 0:00:10:00).

Kegunaan:

¢ Menentukan kedudukan
semasa pada garis masa.

e Boleh diklik dan diseret untuk
berpindah ke waktu tertentu
dalam animasi.

¢ Gunakan pintasan:

. Ctrl + « /» (Windows) atau
Cmd + « /- (Mac) untuk
melangkah satu bingkai ke
depan/belakang.

2. A/V Features Panel
(Audio/Visual Switches)

Panel kecil di sebelah Kiri setiap

layer yang membolehkan

pengguna mengawal paparan dan

bunyi.

Kegunaan:

e Mata (©) —sembunyi/tunjuk
lapisan.

o Speaker (€) - hidup/matikan
audio.

e Solo( )-paparkan hanya
lapisan terpilih.

e Lock (@) - kuncilapisan supaya
tidak boleh disunting.

e Shortcut:

e Tekan Shift + S untuk akses
pantas kepada tetapan paparan
audio/video.

18
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Pane
Current Time mple
Display \

AN features
Panel
Layer Details

Show/Hide
Timeline
Panes

3. Layer Details

Menunjukkan semua lapisan
(layers) yang terdapat dalam
komposisi.

Mengawal tetapan asas seperti
Anchor Point, Position, Scale,
Rotation, dan Opacity.
Menambah keyframe untuk
animasi.

Shortcut penting:

P — Position

S —Scale
R — Rotation
T - Opacity

U —Tunjukkan semua keyframe
aktif

Parenting

Panel

‘/

Frame Level
Zoom

Time Graph
Area

.

|
|

Layer
Duration Bar

Comp Marker
Bin

4. Switches Panel

Panel ini mengandungi suis
tambahan untuk mengawal fungsi
teknikal lapisan.

Kegunaan utama:

Setiap lapisan boleh mewakili imej, o
video, teks, bentuk, audio atau
kesan visual.

Kegunaan:

Motion Blur (tiga bulatan
bertindih) — aktifkan kesan

kabur semasa pergerakan.
Adjustment Layer (garis
pepenjuru) —guna lapisan untuk
efek global.

3D Layer (kubus) — aktifkan ciri
3D untuk lapisan.

Frame Blending — lembutkan
pergerakan antara bingkai.

© Tip: Anda boleh toggle antara
Switches dan Modes menggunakan
butang di bawah panel.
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Parenting
Panel

Pane

Current Time
Display
AN features
Panel

Layer Details

=

Show/Hide
Timeline
Panes

6. Time Graph Area

Ruang utama untuk melihat dan

mengawal keyframe sepanjang

garis masa.

Kegunaan:

¢ Menentukan bila elemen mula
dan berhenti.

e Boleh ubah kedudukan
keyframe untuk kawalan masa.

e Gunakan Graph Editor untuk
melaras kelajuan (easing curve).

e Shortcut:

e Shift + F3 - buka/tutup Graph
Editor.

8. Layer Duration Bar

‘/

Frame Level

Zoom

.

|
|

Layer
Duration Bar

Time Graph Comp Marker
Area Bin

Comp Family
Button

7. Comp Marker Bin

Menambah penanda (markers)
pada garis masa untuk
menandakan titik penting seperti
perubahan babak atau peralihan
bunyi.

Kegunaan:

e Tekan Shift + 8 atau ***
(asterisk)** pada papan kekunci
nombor untuk tambah
penanda.

o Klik dua kali penanda untuk
ubah nama atau warna.

Setiap lapisan diwakili oleh bar berwarna pada garis masa.

Kegunaan:

¢ Menunjukkan tempoh aktif sesuatu lapisan dalam komposisi.
¢ Boleh dipendekkan atau dipanjangkan dengan menyeret hujung bar.

e Shortcut:

o Alt+[/]-potong permulaan atau penghujung lapisan pada titik

semasa.
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Display

Parenting Time Graph Comp Marker
Panel Area Bin

Current Time 7 = ] / ~_

AN features

Layer Details /

|

Layer
Duration Bar

Show/Hide

Timeline Frame Level
Panes Zoom

9. Frame Level Zoom 10. Show/Hide Timeline Panel

Alat zoom di bahagian bawah Butang di sudut bawah Kiri panel

panel. yang membolehkan pengguna
Kegunaan: papar atau sembunyikan ruang
e Mengawal skala garis masa — tambahan seperti:

zum masuk untuk kerja e Audio waveform

animasi halus, atau zum keluar e Effects controls

untuk lihat keseluruhan projek. e Switches/Modes
e Shortcut: o Kegunaan:

Gunakan + /- (nombor barisan
atas) untuk zoom in/out
timeline.

11. Comp Family Button

Mengurangkan keserabutan
paparan semasa bekerja
dengan banyak lapisan.

Ikon di hujung kanan atas panel yang membolehkan anda kembali ke
komposisi induk (main comp) jika sedang bekerja dalam komposisi
bersarang (nested composition).
Kegunaan:

Navigasi cepat antara pre-comp dan main comp tanpa perlu buka

semula dari Project Panel.
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Mengimport Footage
ke Dalam After Effects

B Adobe After Effects 2021 - Uy
File Edit Com

Ctrle Alt Shift+O

CuleW

Ctrt-Alt Shift -

Import e, Ctrlel
Import Recent Footage ulty Ctrl Alts|
Export

Add Fonts

Adobe Dyn:

Find CtrleF

Watch Folder.

Scripts

Project Settings. CtrAlt Shift <K

Bit i

1.0 Pengenalan

Setelah anda mencipta komposisi, langkah
seterusnya ialah memasukkan footage
(rakaman video, imej atau grafik) ke dalam
projek.

After Effects menyediakan beberapa kaedah
mudah untuk mengimport bahan media,
sama ada satu fail video atau siri imej
berurutan (image sequence).

Kaedah 1: Melalui Menu Import (File »
Import > File...)

1.Pergi ke menu File » Import » File...

2.Pilih bahan yang ingin dimasukkan
(contohnya .mp4, .mov, .png, jpg, atau
.psd).

3.Klik Import as Footage jika ingin
masukkan satu klip sahaja.

4. Klik Import as Composition jika ingin
masukkan satu folder dengan beberapa
lapisan (contohnya fail Photoshop atau
Illustrator).

Kaedah 2: Seret & Lepas (Drag and Drop)

1.Buka File Explorer (Windows) atau Finder
(Mac).

2.Seret fail terus ke dalam Project Panel di
After Effects.

3.Footage akan dimasukkan secara
automatik.

Kaedah 3: Cipta Komposisi Baharu
daripada Footage

1.Klik kanan pada footage dalam Project
Panel.

2.Pilih New Composition from Selection.

3. After Effects akan mencipta komposisi
baharu menggunakan tetapan sama
seperti footage (resolusi dan FPS).
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Menamibah Footage ke
Dalam Komposisi

» @ Compositiol

Format Fail yang Disokong oleh After Effects

Jenis Fail Format

i Video 99 Ask ChatGPT mps, .mov, .avi

E Imej g, .dpg, -tiff, .tga

m= Image Sequence .png sequence , .tga sequence
@ Photoshop / lllustrator

% Audio

Pastikan anda mempunyai komposisi
aktif.

Seret footage dari Project Panel ke dalam
Timeline Panel atau Composition
Window.

Jika saiz footage tidak sepadan dengan
dimensi komposisi:

Klik kanan pada footage » Transform - Fit
to Comp

Pintasan papan kekunci: Alt + Ctrl + F
(Windows) atau Option + Cmd + F (Mac)

arked_preview.mp4 v

2 a @ T

o] waterma..._preview.mpa LI

Menyemak Maklumat Footage (Metadata)
Untuk melihat maklumat teknikal footage:

1.Klik kanan pada footage -» Interpret

Footage » Main...

2.Anda boleh semak:

o Resolusi (contohnya 1920 x 1080)
o Kadar bingkai (contohnya 25 fps)
o Tempoh klip (contohnya 00:00:16:00)

Kegunaan

Klip video utama, rakaman kamera
Grafik statik, latar belakang

Siri imej untuk animasi

Lapisan reka bentuk boleh disunting

Lagu latar, efek bunyi
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Mengurus Layer & Solid
dalam After Effects

Menambah ke Komposisi

1.Seret imej yang telah diimport ke Timeline

Panel.
2.Jika imej tidak memenuhi bingkai
komposisi:
o Klik kanan pada lapisan » Transform -» Fit
to Comp Height
o Pintasan papan kekunci: Alt + Ctrl + Shift
+ F (Windows) / Option + Cmd + Shift + F
(Mac)

Mengatasi Ruang Kosong (Empty Frame Area)
Kadangkala, selepas disesuaikan, bahagian kiri atau kanan komposisi masih mempunyai ruang

kosong (warna hitam).
Untuk menutup ruang ini tanpa mengherot imej, anda boleh tambah lapisan Solid.

Menambah Lapisan Solid

Apa itu Solid?
Solid ialah lapisan warna rata (flat color) yang
digunakan sebagai latar belakang atau asas
visual.
Langkah 1: Membuat Solid
1.Klik kanan dalam Timeline Panel » New -»
Solid...
2.Tetingkap Solid Settings akan muncul.
3.Tetapkan dimensi sama seperti komposisi
(contohnya 1920 = 1080).
4. Pilih warna menggunakan Color Picker,
kemudian klik OK.

Masking & Blending (Gabungan Lembut)
Untuk mencipta kesan lembut antara imej

dan latar belakang:

1.Pilih Rectangular Tool (Q) di Toolbar.

2.Lukis bentuk segi empat di atas lapisan imej
— ini mencipta mask.

3.Tekan M untuk membuka tetapan Mask.

4.Ubah nilai Mask Feather untuk
melembutkan tepi imej.

Hasil:
Tepi imej akan tampak lebih lembut dan

menyatu dengan warna latar belakang Solid.
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Mengimport Fail
Photoshop & Illustrator ke
After Effects

Mengimport Fail Photoshop (PSD)

Langkah-langkah:
1.Klik kanan di dalam Project Panel » pilih

Import - File...
o x] 2.(Atau gunakan pintasan papan kekunci:
Ctrl+1/Cmd +1)
v 3.Pilih fail Photoshop .psd yang ingin
> dimasukkan.
4. Tetingkap Import Kind akan muncul
seperti berikut:
Footage:
= o Fail akan dimasukkan sebagai satu
- " . = imej tunggal (gabungan semua

lapisan).
o » Sesuai untuk reka bentuk ringkas
atau apabila tidak perlukan
Composition: suntingan lapisan
Fail dimasukkan sebagai komposisi baharu dalam After Effects.
» Setiap lapisan Photoshop akan kekal berasingan dalam timeline.

Composition — Retain Layer Sizes:
Menyimpan saiz asal setiap lapisan (layer) mengikut dimensi asal dalam Photoshop, bukan

mengikut saiz komposisi After Effects.
» |ni pilihan terbaik untuk kerja animasi yang memerlukan ketepatan kedudukan setiap

elemen.
Pilih Composition — Retain Layer Sizes, kemudian tekan OK.

Kelebihan Import Fail Adobe (PSD & Al)

Kelebihan Keterangan

Integrasi lancar Tiada kehilangan kualiti atau lapisan semasa diimport.

Suntingan fleksibel Boleh ubah kedudukan, warmna dan gaya terus di After Effects.

Animasi berlapis Setiap lapisan boleh digerakkan secara individu (contohnya animasi teks,

logo, atau karakter).
Kualiti tinggi Fail vektor Al kekal tajam walaupun dizum besar.

Keserasian Adobe Sokongan penuh antara Photoshop — After Effects — Premiere Pro.
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Mengimport Fail
Photoshop & Illlustrator ke
After Effects

Mengimport Fail Photoshop (PSD)

Langkah-langkah:
1.Klik kanan di dalam Project Panel » pilih
Import - File...

s ] 2.(Atau gunakan pintasan papan kekunci:
" Ctrl +1/Cmd + 1)
v 3.Pilih fail Photoshop .psd yang ingin
. I dimasukkan.

. 4. Tetingkap Import Kind akan muncul
seperti berikut:

Footage:
= o Fail akan dimasukkan sebagai satu
- - " = imej tunggal (gabungan semua

el O N
lapisan).

o » Sesuai untuk reka bentuk ringkas
atau apabila tidak perlukan

Composition: suntingan lapisan

Fail dimasukkan sebagai komposisi baharu dalam After Effects.

» Setiap lapisan Photoshop akan kekal berasingan dalam timeline.

Composition — Retain Layer Sizes:
Menyimpan saiz asal setiap lapisan (layer) mengikut dimensi asal dalam Photoshop, bukan

mengikut saiz komposisi After Effects.
» |ni pilihan terbaik untuk kerja animasi yang memerlukan ketepatan kedudukan setiap

elemen.
Pilih Composition — Retain Layer Sizes, kemudian tekan OK.

Kelebihan Import Fail Adobe (PSD & Al)

Kelebihan Keterangan

Integrasi lancar Tiada kehilangan kualiti atau lapisan semasa diimport.

Suntingan fleksibel Boleh ubah kedudukan, warmna dan gaya terus di After Effects.

Animasi berlapis Setiap lapisan boleh digerakkan secara individu (contohnya animasi teks,

logo, atau karakter).
Kualiti tinggi Fail vektor Al kekal tajam walaupun dizum besar.

Keserasian Adobe Sokongan penuh antara Photoshop — After Effects — Premiere Pro.
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Mengurus Projek & Fail
dalam After Effects (Collect
Files

File Edit Composition Loyer Effect Animation View Window Help

New

o o e . Dalam penghasilan projek VFX atau Motion
Z::;::":"m" ) S Graphics, satu komposisi biasanya
Browse in Bridge, CulsAlsShit+0 melibatkan pelbagai fail sumber (assets)
Close culew seperti video, imej, fail Photoshop (PSD), fail
ki ) Illustrator (Al), serta beberapa composition
Save As > berasingan.
Increment and Save Ctrl+Alt+Shift+S
Import > Apabila  projek ini dipindahkan ke
:j:::““‘"“”‘”ge komputer lain atau dikongsi bersama
o g pasukan, After Effects mungkin tidak dapat
Adobe Dynamic ik mencari lokasi asal fail dan akan
Find CokeE memaparkan mesej Missing File.
s Sl Untuk mengelakkan masalah ini, After
Dependendies > Colecthes. Effects menyediakan fungsi Collect Files —
LEELC A Conotdn e yang membolehkan anda menggabungkan
e . EEpea semua bahan dan komposisi ke dalam satu
find Missing Effects folder projek lengkap.

Find Missing Fonts

Find Missing Footage

Langkah-langkah Menggunakan Collect Files

¢ Langkah 1: Buka Projek Aktif
Pastikan semua komposisi dan bahan projek telah dimasukkan serta disimpan dengan betul.

¢ Langkah 2: Akses Menu Collect Files
1.Pergi ke menu atas » File » Dependencies » Collect Files...
2.Tetingkap Collect Files Options akan muncul.

¢ Langkah 3: Pilihan dalam Tetingkap Collect Files

Pilihan Fungsi
For All Comps Mengumpulkan fail untuk semua komposisi dalam projek.
For Selected Comps Hanya kumpulkan fail untuk kompasisi yang cipilih.

For None (Project Only) Menyimpan hanya fail projek .aep tanpa bahan luaran.

¢ Hasil Projek

W Hasil Akhir
After Effects akan menghasilkan folder baharu dengan struktur seperti berikut:

o @ Copy code

Project_Folder/
|

}— Projectiiane
|— Footages

| = video

= e
|— design

— image_sequence/

|
|
|
|
L CollectFiles Report
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STUDIO WORK : Basic Compositing
& Layer Control

Arahan:

Pelajar perlu membina projek video berdurasi 10-15 saat menggunakan 3-5
elemen media (gambar, PSD/AI, teks dan solid).

Projek ini menunjukkan kefahaman asas antaramuka AE, fungsi layer dan teknik
transformasi asas seperti pergerakan dan pemudaran (fade in/out).

Langkah 1: Setup Projek Langkah 2: Import & Urus Media
Buka Adobe After Effects. Import sekurang-kurangnya:
Cipta komposisi baharu: o 1imej (jpg/.png)
o Nama: StudioWork2_BasicCompositing o 1 fail reka bentuk (.psd atau .ai)
o Resolusi: 1920x1080 o Taudio ringkas (optional)
o Frame Rate: 25 fps Susun fail ke dalam folder (bins) seperti
o Duration: 10-15 saat Images, Design, Audio.
o Background: Hitam

Langkah 3: Layer & Solid Langkah 4: Masking & Transformasi Asas
Tambah satu Solid Layer sebagai latar
belakang (Ctrl +Y).

Letakkan imej / PSD di atas solid layer.

e Tambahkan satu Text Layer dengan tajuk
pendek (contoh: “MY FIRST VFX
PROJECT").

Gunakan Character Panel untuk ubah warna
dan saiz font.

Gunakan Shape Tool (Q) atau Pen Tool (G)
untuk membuat mask pada imej.
Lembutkan tepi dengan Feather (F).
Tambahkan animasi asas:
o Position (P) - gerakkan imej
masuk/keluar.
o Opacity (T) - buat kesan fade in/out.
o Rotation (R) — putaran mudah pada
teks.
Aktifkan Motion Blur pada lapisan animasi.

Langkah 5: Eksport Projek

e Simpan projek:
StudioWork2_[NamaAndal.aep

e Eksport video .mp4 menggunakan format
H.264 (HD 1080p).

e Gunakan Collect Files untuk simpan semua
aset dalam satu folder.
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Bab 2

Asas Visual Effects
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Bab 2:

Asas Visual
Effects

Kesan visual atau Visual
Effects (VFX) merupakan
elemen penting dalam

penghasilan video dan filem
moden. la digunakan untuk
menambah atau mengubah
sesuatu adegan bagi
menjadikannya lebih
menarik dan realistik. Tidak
seperti Special Effects (SFX)
yang dilakukan secara fizikal
semasa penggambaran, VFX
dihasilkan menggunakan
komputer dalam proses
pasca-produksi.

Modul kedua ini memberi
pendedahan kepada asas
pembinaan kesan visual (VFX)
menggunakan Adobe After
Effects.Anda akan
mempelajari bagaimana
lapisan, blending mode, dan

alpha channel berfungsi
dalam membentuk komposisi
digital.

Selain itu, modul ini turut
memperkenalkan teknik
green screen dan rotoscoping
— dua kaedah utama yang
digunakan untuk
menggabungkan subjek
sebenar ke dalam latar maya
dengan hasil yang realistik
dan profesional.
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Bab 2:

Perbezaan antara SFX dan VFX

Dalam dunia produksi kreatif, kita sering mendengar dua istilah
yang kedengaran serupa tetapi sebenarnya berbeza dari segi
fungsi dan proses: Special Effects (SFX) dan Visual Effects (VFX).

Practical Special Effects

SFX merujuk kepada kesan
khas yang dilakukan secara
fizikal semasa penggambaran.

Contohnya termasuk:

e Letupan sebenar  yang
dikawal oleh pasukan
keselamatan.

e Percikan api atau hujan
buatan yang dicipta
menggunakan peralatan
khas.

e Solekan prostetik untuk
mencipta kesan luka,
raksasa atau makhluk
fantasi.

Semua kesan ini berlaku

secara langsung di lokasi

penggambaran dan dirakam

terus oleh kamera. la
memerlukan kepakaran
teknikal dan perancangan

teliti kerana tiada ruang untuk
kesilapan semasa rakaman.

Diaital Visual Effects

VFX, pula, dihasilkan selepas
penggambaran—dalam fasa
pasca-produksi menggunakan
perisian komputer seperti
Adobe After Effects.

Melalui VFX, editor video boleh:

¢ Menambah bangunan digital
atau langit tiruan.

¢ Menggantikan latar
belakang menggunakan
teknik green screen.

¢ Menyisipkan animasi,
partikel, atau elemen grafik
yang tidak wujud semasa
rakaman.

VFX memberi ruang kepada
kreativiti tanpa batas dan
membolehkan penghasilan
visual yang mustahil dilakukan

secara fizikal.
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Properties: BANDAR BARU
Layer Transform
(@ Anchor Point
Position
Scale

Rotation

Opacity
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Praktikal: Mengenali dan Mengawal Layer

Dalam latihan ini, anda akan mempraktikkan cara mengenal
pasti, menambah, dan mengawal pelbagai jenis layer dalam
Adobe After Effects.

SCAN ME

Scan untuk bahan latihan

34



SIRI 1: Pengenalan dan Asas Komposisi
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Praktikal: Mengenali dan Mengawal Layer

6. Tambah keyframe pada Position di lapisan Video untuk mencipta animasi
ringkas.

Seri w. oo aovimsos op . KEYFRAME
: u e 7 ’ .

|/ -ih”l'&“.:'

MW':?“‘

\mar-,s‘ '

w‘

® Tip: Gunakan warna label berbeza untuk memudahkan pengurusan banyak
lapisan.
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Blending Mode dan Alpha
Channel

Blending Mode digunakan untuk
menentukan cara lapisan berinteraksi
antara satu sama lain. la mengawal
bagaimana warna dan cahaya daripada
lapisan atas bercampur dengan lapisan
bawah untuk menghasilkan kesan visual
tertentu.

Sebagai contoh:

e Screen - mencerahkan imej dan
sering digunakan untuk kesan cahaya
atau sinaran.

e Multiply - menggelapkan imej, sesuai
untuk menambah bayangan atau
tona.

e Overlay - menggabungkan
pencahayaan dan kontras bagi
menghasilkan kesan dramatik.

Coor Untuk mengaktifkan blending mode, klik
— butang Toggle Switches/Modes di
bahagian bawah timeline (atau tekan F4).
e Senarai mod akan muncul di sebelah
Aipna g kanan nama lapisan.

Luminescent Premul

P xELDE ar
a -1 & Maor L G
B e MNaor vop )
Rajah 2.1:

Blending mode aktif

Alpha Channel pula berfungsi sebagai saluran ketelusan
(transparency). la menentukan bahagian mana daripada imej
yang kelihatan dan bahagian mana yang telus.

Sebagai contoh, apabila anda menggunakan logo dengan latar
belakang lutsinar ((PNG), maklumat alpha channel
membolehkan anda meletakkan logo tersebut di atas video37
tanpa latar belakang putih.
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Prinsip Asas Komposisi

Pengenalan

Komposisi ialah proses
menggabungkan pelbagai
elemen visual seperti video,

imej, teks dan grafik untuk
menghasilkan satu paparan
yang kelihatan menyatu dan
realistik. Dalam Adobe After
Effects, proses ini dilakukan
dengan menyusun lapisan
(layers), menggunakan mod
penggabungan (blending
modes) serta melaraskan
warna dan pencahayaan (color
adjustment) agar semua
elemen kelihatan sebahagian
daripada satu adegan

Tujuan utama komposisi
adalah  untuk memastikan
setiap elemen dalam sesuatu
projek kelihatan harmoni dari
segi warna, cahaya, dan
perspektif. Apabila kesemua
unsur ini disusun dengan betul,
hasil akhirnya akan menyerupai
rakaman sebenar dan bukan

gabungan digital yang
kelihatan asing atau
“dilekatkan”.

Apabila prinsip ini diamalkan,
hasil komposisi akan kelihatan
lebih profesional dan semula
jadi.

Antara prinsip asas dalam

komposisi ialah:

1.Keseragaman warna - pastikan
tona warna elemen tambahan
sepadan dengan latar belakang.

2.Keseimbangan cahaya dan
bayang - arah dan intensiti
cahaya perlu konsisten antara
elemen.

3.Kedalaman ruang (depth) -
gunakan saiz dan kedudukan
untuk mewujudkan kesan jarak
realistik.

4. Keselarasan perspektif -
pastikan sudut pandang dan
arah objek selaras dengan latar
utama.

S.Integrasi visual - elakkan tepi
objek kelihatan terlalu tajam
atau berbeza pencahayaan
daripada latar.
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Color Grading dan Blending
untuk Realisme

Color grading dan blending ialah dua elemen penting dalam
mewujudkan hasil visual yang realistik dan profesional. Dalam
penghasilan kesan visual, kedua-dua proses ini membantu
menyatukan warna, pencahayaan dan suasana keseluruhan agar
semua elemen dalam sesuatu komposisi kelihatan seolah-olah
dirakam dalam persekitaran yang sama.

Effects & Presets

joii

¥ * Animation Presets
» 3D Channel

» Audio

» Blur & Sharpen

» Boris FX Mocha

» Channel

Color Grading dan Blending » Cinema 4

» Color Correction

juga boleh dibuka » i
menggunakan short cut key S
Ctrl + 5 (Windows) / Cmd + 5 mresevies
(Mac) R

¥ Perspective
¥ Simulation
» Stylize

» Text

¥ Time

» Transition

» Utility 3%
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Color Grading

Color grading merujuk kepada proses melaras warna, kontras dan
tona bagi menghasilkan mood atau suasana tertentu. Proses ini
biasanya dilakukan menggunakan panel Lumetri Color atau Curves
dalam Adobe After Effects.

0000000 o CEBON g E e e n = 0008 ® 1 aime so\pm00
<N m oEsmmT S
c0ed 3 2660 s 8 W BESEE Y

contoh penggunaan Curves sebelum sunting contoh penggunaan Curves selepas sunting

. I —, N . . "o
POLITE&KMNIK POLITEKNI
E=MALAYS|A=— ——MALAYS | Am—
TR SVED CURAEDOIS TOANKD £¥D SrmATODDIN
CELT o @ BoEE? 40w a
contoh penggunaan Lumetri sebelum sunting contoh penggunaan Lumetri selepa sunting

Melalui color grading, anda boleh menyeragamkan warna antara
elemen atau menambah gaya sinematik pada rakaman.

Project x B & Effect Controlspiss.png =

Comp 1 - ptsspng

Antara pelarasan asas yang biasa ~ A 88 Exposure Reset
H H . D channels: Master v
digunakan ialah: O
» O Exposure 0.00
1. Exposure dan Contrast — B —
Mengawal kecerahan keseluruhan >
imej dan membezakan kawasan 2

terang serta gelap.

O Temporal Smoothing (se 0.00

O Black clip 010% 40
) white Clip 010%
© Blend With Original 0.0%
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Color Grading

2. Temperature dan Tint - Melaras

suhu  warna Temperature
menukar imej menjadi  lebih
kebiruan (sejuk) atau kekuningan

(hangat). Tint pula mengimbangi
ton hijau dan magenta.

Project x B @ Effect Controls ptsspng =
Comp 1 - ptss.png
R¥EH -] Hue/saturation Reset
Channel Control Master v
~ [ Channel Range
i TR T T
[l TR 111 0BT
~Master Hue 0x+0.0°
v Master Saturation 0
-100 100
~ Master Lightness 0
-100 100
o
0O colorize
>
>
>

4. Shadows dan Highlights -
Mengimbangi kawasan terang dan
gelap supaya butiran penting kekal
kelihatan.

Project

x B & Effect Controlsptsspng =

[Comp 1 - plss.png

NVl Tint | Reset
) Map Black To ==
) Map White To H —
» 5 Amount to Tint 100.0%
Swapcolors |
3. Saturation - Menentukan
tahap keceriaan warna. Nilai
terlalu tinggi menjadikan imej

kelihatan tidak semula

jadi.

Project x B & Effect Controlsptsspng =
Fomp 1 - prsspng
v fx Reset
) Auto Amounts
b3
b3

> OTemporal Smoothing (se 0.00

» More Options

» U Blend with Original 0.0%
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Blending

Blending digunakan untuk menyatukan dua atau lebih lapisan
supaya peralihan antara elemen kelihatan lembut dan semula jadi.

N

B comp1 =
0,00:00;00

Blending mode menentukan bagaimana warna

lapisan atas
berinteraksi dengan lapisan di

bawah. Antara mod yang sering

digunakan:

LR R * O, T J. PR, O snapping < [ Defautt Lear
1. Screen: ' _ /| (il J———
Mencerahkan imej — N~ BREmNg
sesuai untuk kesan Hasil Blending mode )
cahaya, api, atau Screen NEWS
kabus. st -

-

B omp1 =
0002929 o

ohed ¥ ¢ iy 8
o vE: B gl ®
© opaciy 100%
>H 2 B [smokepng] @/
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Blending

2. Multiply:
Menggelapkan imej —
digunakan untuk
kesan bayangan atau
tona tekstur.

Hasil Blending mode
Multiply

u v BREAEE 40 ] 0002929

Hasil Blending mode
Overlay

/%1 3. Overlay:
Menggabungkan
= kontras —
NEWS

menjadikan warna
lebih hidup dan
dramatik.

B comp1 =
0002929 o,

ohed @ ¢
o] B

4. Soft Light: Kesan
lembut seperti
pencahayaan semula
Jadi

,‘
& W R, O swopprg < (B

osbreaingnewsipg = »  x B & Compostioncomp =

1 BBEA;(IF'G

Hasil Blending mode}; L
Soft Light NEW s

< B compr =
0002929 o

ched @ s
o] vE1

© ot
>E2
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Blending

Hubungan Antara Color Grading dan Blending

Color grading dan blending saling melengkapi. Blending
menentukan bagaimana dua lapisan berinteraksi, manakala
color grading memastikan warna keseluruhan kelihatan
seimbang.

Gabungan kedua-dua teknik ini penting untuk mengekalkan
realisme dalam kesan visual.

Sebagai contoh:

e Gunakan Screen pada lapisan cahaya, kemudian laraskan
Temperature ke arah warna hangat bagi mencipta suasana
petang.

e Gunakan Multiply pada bayangan, kemudian kurangkan
Saturation untuk mengelakkan warna terlalu kuat.

e Hasil akhirnya akan kelihatan semula jadi dan selaras dari
segi warna dan cahaya.

Rumusan

Color grading dan blending ialah gabungan teknik yang
memberi “jiwa” kepada hasil visual. Melalui pemilihan warna,
kawalan pencahayaan, serta penggunaan blending mode yang
sesuai, pelajar dapat menghasilkan visual yang bukan sahaja
menarik, tetapi juga kelihatan realistik.

Kuasai kedua-dua asas ini, dan anda akan dapat mengubah
rakaman biasa menjadi karya visual yang menonjol dan
profesional.
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Praktikal: Komposisi Video dan Elemen Grafik

Dalam latihan ini, anda akan mempelajari cara menggabungkan
rakaman video dengan elemen grafik seperti teks, bentuk, atau
logo untuk menghasilkan komposisi visual yang seimbang.

SCAN ME

Scan untuk bahan latihan
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B Effect Controls hologram.png

Import Video ke dalam
project panel

|| hologrampng [ IV 37 KB

street;.‘empal B Importe.MEX 125 MB

v EFRAES & G0 @d

e BEON
REAEOPD® Mude T TackMatte [IFF Parent&Link
Jo] street scenemps |G Nev | J@ Nev @I None

_Animation Hel
LDE EAT /128 3 2

Project B fictControls hologrampng « W & compostioncomp1 =

Smallscreen Standard.

Propertes: hologram png
Layer Transform
Anchor Point

-~ T S FameRa. InPont

2 comp1 W Composition 2 000 %~
[SYhoogomeng [ I RN

DESWEE 8 impote vex 125M5 25 000

- = Lapisan hologram diatas. £
~= dapisan video

OF puentsunk
@I None
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« W comp1 =

0000000 o Tukar blending modeke Screen .. 4 @ o

o®eld W & SouceName 2ENHAEOOO TrackMatte  [OF7 Parent & Link

o] /1t @ Ne v @I None
9600,560.0 @

 2000,2000% ]

L Va @ Ne v @ None

FRAEE & 6o

Project x B @ Effect Controls hologram.png.
Comp 1- hologrampng
Ry L umeri color | Reset
Basic Correction
Active
Input LUT [
v color
‘Wwhite Balance
> O Temperature
> OTint
> O saturation

> O Contrast

> O Highlights
> © shadows
> O Whites.

> O Blacks

> Creative
~Curves

RGB Curves

VRGB Curve

v RREEE & 00 0:00:0000
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x M comp1 =
0:00:00:00 g A EO

C0eB B ¢ SoucelName RENHEOPD  Mde T TockMate O Parentslink
©] vl 1 Blcdogmmpg 1% /fx sav IO Ne v @I nNone

9600,5600

O2.T. Al & & - smalsareen Standard Ubraries

B & efectconrotshologrampng. = propete: hologram png
‘Comp 1 - hologram.png.
Rl et oo | Reset

> Basic Comecton

> crsatve

> Colorwheets

> st seconday

> vignete

oocor12
x W comp1
0:00:01:12

ove@d 24 \HBOP®
o) M= S/

96002180
@ 2000,2000%
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Project x B & Effect Controls green catmp4

Comp 1 - green catmp4
v fx Keylight (12) Reset
wAbout

6 KEYLIGHT

View Final Result v
D Unpremultiply Result
T Screen Colour o =

» O Screen Gain 100.0
» U screen Balance 50.0
) Despill Bias L
D Alpha Bias o=
Lock Biases Together
» U Screen Pre-blur 00
vScreen Matte
» O clip Black 00
» O clip White 100.0
» O clip Rollback 0.0
> O screen Shrink/Grow 0.0
» © Screen Softness 00
» ) Screen Despot Black 0.0
» ¥ Screen Despot White 0.0
Replace Method Soft Colour
O Replace Colour N =
> Inside Mask
» Outside Mask
> Foreground Colour Correction
> Edge Colour Correction
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Teknik Green Screen &
Chroma Keying

Prinsip Asas Chroma Keying
Chroma Keying berfungsi dengan menghapuskan satu warna

dominan (biasanya hijau atau biru) daripada video, dan
menggantikannya dengan latar baharu.

Syarat asas untuk hasil keying yang baik ialah:

1. Pencahayaan sekata - tiada bayang kuat di belakang subjek.
2. Latar bersih — warna hijau tidak bercampur dengan warna
pakaian subjek.

3. Kontras tinggi — subjek dan latar perlu jelas berbeza warna.

Chroma Keying terletak di dalam effects, secara asasnya boleh
menggunakan short cut key: Ctrl+5 (Windows) / Cmd + 5 (Mac).

4

Rajah 2.2:

Contoh Subjek di dalam Set Green Screen

® Nota: Warna hijau digunakan kerana sensor kamera paling sensitif terhadap
hijau, menjadikannya mudah untuk dihapus tanpa menjejaskan warna kulit
manusia
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Praktikal: Langkah Asas Chroma Keying dalam After
Effects

Dalam latihan ini, anda akan mempelajari cara menggunakan
teknik Chroma Keying untuk menukar latar belakang video yang
dirakam menggunakan green screen. Teknik ini membolehkan
subjek dipisahkan daripada warna latar tertentu (biasanya hijau
atau biru) dan digantikan dengan imej atau video baharu.

SCAN ME

Scan untuk bahan latihan
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ARVQA S+ 1 DEONT /L8 3 2 A A W O s Small Scren Sandard Librrie

Efect Contr & compostton(oone) = Propertie: NoSelection

‘composition Name: | Green screen Test

Bask  Advanced 3D Renderer

- % > Preset | HD - 1920110802997 s
O EERITI  imporie MEX 43145
DT & importe X 6410 wh: 1920 pe
Lock Aspect Ratio to 16:9 (1.78)

g 1000 Cipta Komposisi Baru

Pixel Aspect Ratio: | Square Pixels v | Frame Aspect Ratio:
169 (178)

Frame Rate: v famespersecond | Drop Frame

Resolution: | Full v 19201080,79 M8 per sbpc frame
Start Timecode: | 0,00,00,00  150,00,00,00 Base 30 drop

Duration: | 0,00:36;00  50,00,3000 Base 30 drop.

2 ok

B Green Screen Test
0,00;00,00 g,
Cheh B 1 Soucc

> o T © RO rene
B vomerimp: | e v I8 e v I e

RENHAEOQ® Mot T Tockmate O Paentslok
/] Ne n

omay

- Boa

“+@08

8000 w1 e OF remisins
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Praktikal: Langkah Asas Chroma Keying dalam
After Effects

KEYLIGHT
5. Dalam Effect Controls, ‘@ cEyedrol
klik Eyedropper Tool pada g
“Screen Colour”.
¢ 51KIlik pada kawasan
hijau di latar video.

5. Dalam Effect Controls, - y—
klik Eyedropper Tool pada S G 5
w " Warna hijau
Screen Colour”. Hipac
e 52 Warna hijau akan i »
dipadam secara
automatik.
« - [ | — Z > = _
Green Screen Test - green cat. ND4
v f
wAbout
KEYLIGHT
@ 6. Gunakan pelarasan tambahan:
View Final Result v .
: e T e Screen Gain: m?ngawal kekuatan
2\ Scxeen Colow - penghapusan hlJaU.
» D Screen Gain .
» 1) Screen Balance Larasikut o Screen Balance: menstabilkan tona
Despill Bias == kesesuaian A
& AptaBias = warna selepas Ifeylng..
Lock Biases Together ° Cllp Black / Cllp Whlte:
> Screen Pre-blur o o 0o
e menghapuskan sisa tepi hijau.
> O clip Black
> ) Clip White . . . .
> O Clip Rollback 7. Jika tepi subjek kelihatan kasar,
> O Screen Shrink/Grow o
> © sceen sftness pergi ke Screen Matte > Screen
> O Screen Despot Black Softness dan naikkan nilai sedikit (1-3).
> (O Screen Despot White
Replace Method Soft Colour v
5 Replace Colour =
» Inside Mask
» Outside Mask
» Foreground Colour Correction 53

» Edge Colour Correction
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Praktikal: Langkah Asas Chroma Keying dalam
After Effects

8. Gunakan scale (50%) dan position (260,828) untuk suaikan video green screen
dengan video environment. Shortcut key S dan P.

odle G D = Source Name B EOQD ode T TrackMatte [Jf7 Parent&Lin
od) -l 1 B Egreen catmp4 £ fx Norr @ Noh

cale (=]

® Tips: Elakkan pencahayaan subjek yang terlalu terang berbanding latar belakang
— ia akan nampak tidak selaras.

Rumusan

Teknik green screen dan chroma keying membolehkan penggabungan
dunia sebenar dengan dunia digital secara kreatif.

Dengan pencahayaan yang betul, warna yang seimbang, dan penggunaan
Keylight yang tepat, pelajar boleh menghasilkan video realistik tanpa perlu
berada di lokasi sebenar. 54
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Teknik Rotoscoping

Pengenalan

Rotoscoping ialah teknik mengasingkan atau mengeluarkan
subjek daripada latar belakang tanpa menggunakan green
screen.

Dalam Adobe After Effects, teknik ini dilakukan dengan melukis
topeng (mask) atau menggunakan alat Roto Brush untuk
menjejak pergerakan subjek bingkai demi bingkai.

Rotoscoping digunakan apabila anda ingin:
e Menukar latar belakang video yang tiada green screen.
e Menggabungkan seseorang ke dalam adegan lain.
e Menambah kesan khas hanya pada subjek tertentu
(contohnya aura cahaya atau bayangan).

la adalah teknik penting dalam kesan visual kerana
membolehkan manipulasi video sebenar secara terperinci.
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Konsep Asas Rotoscoping

Rotoscoping berfungsi dengan memisahkan subjek daripada
latar menggunakan mask atau Roto Brush.

After Effects kemudian menjejak bentuk tersebut sepanjang
pergerakan video untuk menghasilkan potongan bersih subjek.

Dua kaedah utama rotoscoping:

1. Manual Masking:

teknik asas untuk mengasingkan atau menyorok sebahagian
imej atau video menggunakan bentuk yang dilukis secara
manual pada lapisan (layer).

Melukis bentuk topeng (mask) secara manual menggunakan
Pen Tool. Aktifkan guna short cut: G untuk Windows dan Mac
e Sesuai untuk objek statik atau pergerakan perlahan.

File Edit Composition Layer Effect Animatic1 View Window Help

hr¥Q DE T /1 & i 2 O:» O rotopezier B @ Auto-Open Pane

2. Roto Brush Tool:

Roto Brush Tool digunakan untuk mengasingkan subjek
daripada latar belakang secara automatik tanpa menggunakan
green screen.

Menandakan subjek menggunakan berus khas; After Effects
akan menjejak automatik setiap bingkai. Aktifkan guna short
cut: Alt + W (Windows) dan Option + W (Mac).

e Sesuai untuk pergerakan kompleks dan rakaman manusia.

File Edit Composition Layer Effect Animation View Window Help

hr¥Q N O T 18 e
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Praktikal: Langkah Asas Menggunakan Roto Brush

Dalam latihan ini, anda akan mempelajari cara menggunakan
Roto Brush Tool untuk mengasingkan subjek daripada latar
belakang tanpa bantuan green screen. Teknik ini membolehkan
anda menjejak pergerakan subjek secara automatik dalam setiap
bingkai video, menjadikannya sangat berguna apabila subjek
bergerak bebas di hadapan latar yang kompleks.

SCAN ME

Scan untuk bahan latihan
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Import Video ke dalam
project panel

[Nz W Importe.MEX 566 MB 25
Importe..MEX 154 MB 29.97

Composition Settings X

Basic  Advanced 3D Renderer

D - 1920x1080 - 2997 fps
Width: 1920 px

Lock Aspect Ratio to 16:9 (1.78)
Height: 1080 px

Pixel Aspect Ratio: |~ Square Pixels v | Frame Aspect Ratio:
16:9 (178)

Frame Rate: v framespersecond  Drop Frame

Resolution: | Full V| 1920x1080, 7.9 MB per 8bpc frame
Start Timecode:  0;00;00;00 is 0;00;00,00 Base 30 drop

Duration:  0;00;09;00 5 0;00,09;00 Base 30 drop

Background Color: 2 Black

« B RotoscopingTest =

0,00,00,00 o,

Source

Y concvacmoi§

ty backgroundmpa
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Praktikal: Langkah Asas Menggunakan Roto Brush

4. Pilih lapisan video people walk, kemudian klik dua (2) kali untuk
buka dalam Layer Panel.

Rotoscoping Test =

Klik 2x pada lapisan video ini

oVen W # Source Name o i - [ T Trackiitte [Jf7 Parent & Link
=X E3_BERN o] people walkmpa__ NEINNIS nev | J@ N) v O None v

5. Pastikan video
dibuka di dalam layer
panel

6. Aktifkan Roto Brush Tool
Di bar atas, klik ikon berus ungu (Roto Brush Tool).
e Shortcut Key Alt+W (Windows) / Option+W (Mac)

File Edit Composition Layer Effect Animation View Window Help

V¥ Q D O T, /L &
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Project

x M & Eflect Controls people walkmpd =
Rotoscoping Test - people walkimpd.
~ fx Roto Brush & Refine Edge.

Version
> Propagation
Invert Foreground/Background
Matte

ne Edge Radiu
Finetune Refine Edge Mat
Refine Edge Mat

Blur
Decontaminate Edge Colors
> Decontamination

Defaut

Smallscreen standard Uibraries
Propertie: people walkmp4
Layer Transtorm

Anchor point

positon

sale

Rotation

Opacity

x B Rotoscoping Tst
0;00,00,00 o,
ved &«

o
°

tionLayer_Eff

project x M @ Efiect Conirols people walkmpd [
Rotosopin Tes - people walkmpt
i Rolobrush & RefineEdge
Verson
> Propgaton
Invert Foreground/Background 0
fine tune

Reset
30

Decontaminate Edge Colors
> Decontamination

105 125 155 16

165 205

fe\(EOGO

OAT /188 *

W compostion Rotoscoping Test

+ | W 1 000000
0% vEEDHO 0w ad

t 0002209 40002210
0000000 4%

View:

RS EY

Mo T Tokhste O Preresti

Defaut

x M & Layerpeoplewakmps =

Roto Brush & Refine Edge

Smal Sreen Standard Uibraries

Properties: people walkmp4
Layer Transtorm

» B Rotoscoping Tst
00,00 o

fe\HEOG®

Background 21
Background 20

745 % v @ @ 6 W O w00

(3 L B BU13 1 0000000

+ ooo2209
0000000 &8

20002210 View:

TRAEOR

Moo T Toae DIfF paemislok

Roto Brush & Refine Edge
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View: Roto Brush & Refine Edge

383% v @ = M % w00 @5 0000315

x B Rotoscoping Test =
[ TR EQ

opel © ¢ Source Name: 3 T TrackMatte [J[3 Parent& Link
@ Ne v @ None

960.0,800.0 @

x M Rotoscoping Test =
0;00;00;00 o w el e

op)e@d W #  SouceNsme REHEPPD  Mode T TrackMatte [If7 Parent& Link
Ng v @ Ne v @ nNone

0 scle @ 500,50.0% @
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Praktikal: Langkah Asas Menggunakan Roto Brush

10. Pratonton hasil :
e Subjek kini berada di latar baru dengan potongan bersih.

Rumusan

Teknik rotoscoping membolehkan pengasingan subjek tanpa green
screen. Langkah ini merupakan kemahiran penting dalam kesan visual
moden, digunakan dalam filem, iklan, dan kandungan digital untuk
mencipta integrasi realistik antara rakaman sebenar dan elemen rekaan.

Menguasai rotoscoping memberikan asas kukuh sebelum meneruskan ke
tahap lebih kompleks seperti motion tracking dan compositing lanjutan.
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